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The use of recycled plastic requires rigorous 
testing to ensure proper separation and 
identification as some polymers are not 
compatible when mixed. Poor incoming 
raw material inspection can lead to multiple 
production issues. To address this, polymer 
products are “coded” as one of seven codes.  
This greatly assists in the separation when the 
code is visible on the product. This may not 
always be the case when a material is ground 
or bundled. The coding system also fails to 
account for fillers and additives, which may be 
detrimental to finished products. An improperly 

characterized polymer source can ruin an entire day of production due to not only 
incorrect formulation but also the cleaning required for the processing machinery.

The analytical techniques, mostly commonly implemented in the analysis of polymers 
are Differential Scanning Calorimetry (DSC), Thermogravimetric Analysis (TGA), 
and Fourier Transform Infrared Spectroscopy (FT-IR). DSC is primary utilized in the 
determination of melting and/or glass transition temperatures. DSC can also allow 
for polymer ratios to be determined in blended materials. TGA is often utilized to 
detect polymer, filler, and carbon black content. TGA also affords the opportunity to 
determine moisture content, and in some instances, polymer ratios. FT-IR is a first-line 
measurement to assist in the identification of polymers, fillers, and additives. DSC, 
TGA, and FT-IR are key techniques to ensure polymer identification, and the quality of 
the materials received and produced. 

This compendium provides example data and interpretations for the seven codes of 
recyclable polymers. DSC and TGA raw data files are provided so that the user can 
easily overlay their data with the expected results for new unprocessed plastics. This 
allows for a conformation of identity and assists in the analysis of incoming materials. 
An FT-IR library is provided that contains the most commonly encountered plastics 
along with some of the more prevalent additives and polymer blends. Additionally, 
method files are provided for the three instruments to ensure that the data collected is 
in accordance with polymer processing standards.

RECYCLING PACK

INTRODUCTION TO THE 

POLYMER

2



3

Table of Contents

Code 1 	 Polyethylene Terephthalate 
		  a.	 Pure PET Analysis	 4
		  b.	 Method for Differentiating PETE from PETG by DSC 	 6
Code 2 	 High Density Polyethylene
		  a.	 Pure HDPE Analysis	 8
		  b.	 Exemplifying the Variety of PE by DSC	 10
Code 3 	 Polyvinyl Chloride
		  a.	 Pure PVC Analysis	 12
		  b.	 Detection of Additives in PVC by TGA	 14
Code 4 	 Low Density Polyethylene
		  a.	 Pure LDPE Analysis	 16
Code 5 	 Polypropylene
		  a.	 Pure PP Analysis	 18
		  b.	 Analysis of the Effect of Filler on PP by DSC	 20
Code 6 	 Polystyrene
		  a.	 Pure PS Analysis	 22
		  b.	 Comparing HIPS to PS by FT-IR	 24
Code 7 	 Other 
		  a.	 Acrylonitrile Butadiene Styrene
			   i.	 Pure ABS Analysis        	 26
			   ii.	 Detecting ABS Nylon Formulations by DSC	 28
		  b.	 Nylon
			   i.	 Pure Nylon Analysis	 30
			   ii.	 Filled Nylon Comparison by DSC	 32
			   iii.	 Filled Nylon Comparison by FT-IR   	 34
			   iv.	 Filled Nylon Comparison by TGA   	 36
		  c.	 Polycarbonate
			   i.	 Pure PC Analysis           	 38
			   ii.	 Comparing PC to PS by FT-IR 	 40
		  d.	 Poly(Methyl Methacrylate)
			   i.	 Pure PMMA Analysis  	 42
			   ii.	 Comparing PMMA to MPMMA by FT-IR   	 44
			   iii.	 Comparing PMMA to MPMMA by TGA 	 46
Appendix 1	User Guide	 48 

DSC 6000  
Differential Scanning Calorimeter

TGA 4000  
Thermogravimetric Analyzer

Spectrum Two™  
FT-IR Spectrometer



4

FT-IR:

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 1713	 94

	 2	 1409	 97

	 3	 1239	 92

	 4	 1092	 91

	 5	 1016	 93

	 6	 872	 95

	 7	 723	 90
Polyethylene Terephthalate (PET) Applications
• Food packaging 
• Fibers/clothing
• Films
• Electronics

Pure PET Analysis

A P P L I C A T I O N  B R I E F

Code 1a
Polyethylene Terephthalate
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Pure PET Analysis

DSC:

TGA:
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Method:

DSC 4000 or 6000 
Nitrogen 20 mL min-1

	 1.	Heat from 25.00 ºC to 300.00 ºC at 10.00 ºC min-1

	 2.	Hold for 2.0 min at 300.00 ºC
	 3.	Cool from 300.00 ºC to 25.00 ºC at 10.00 ºC min-1

	 4.	Hold for 2.0 min at 25.00 ºC
	 5.	Heat from 25.00 ºC to 300.00 ºC at 10.00 ºC min-1

Polyethylene Terephthalate (PET) Applications
• Food packaging 
• Fibers/clothing
• Films
• Electronics

Method for Differentiating 
PETE from PETG by DSC

A P P L I C A T I O N  B R I E F

Code 1b
Polyethylene Terephthalate
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Method for Differentiating PETE from PETG by DSC

Discussion:

Polyethylene Terephthalate (PET) is a commonly recycled thermoplastic. There are numerous formulations available for PET which 
are optimized for specific applications. In this example, two types of PET are analyzed to demonstrate the DSC’s ability to separate 
polymers based on their glass transition temperatures.

011520_01
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FT-IR:

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 2916	 36

	 2	 2848	 38

	 3	 1737	 97

	 4	 1473	 71

	 5	 1462	 68

	 6	 731	 71

	 7	 719	 60
High Density Polyethylene (HDPE) Applications
• Toys
• Packaging 
• Pipes
• Cabling

Pure HDPE Analysis

A P P L I C A T I O N  B R I E F

Code 2a
High Density Polyethylene
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Pure HDPE Analysis

DSC:

TGA:
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Method:

DSC 4000 or 6000 
Nitrogen 20 mL min-1

	 1.	Heat from 25.00 ºC to 200.00 ºC at 10.00 ºC min-1

	 2.	Hold for 2.0 min at 200.00 ºC
	 3.	Cool from 200.00 ºC to 25.00 ºC at 10.00 ºC min-1

	 4.	Hold for 2.0 min at 25.00 ºC
	 5.	Heat from 25.00 ºC to 200.00 ºC at 10.00 ºC min-1

High Density Polyethylene (HDPE) Applications
• Toys
• Packaging 
• Pipes
• Cabling

Exemplifying the  
Variety of PE by DSC

A P P L I C A T I O N  B R I E F

Code 2b
High Density Polyethylene
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Exemplifying the Variety of PE by DSC

Discussion:

There are many different types of Polyethylene (PE). The codes for polyethylene are 2 (for high density) and 4 (for low density). 
Linear Low Density Polyethylene (LLDPE) and Medium Density Polyethylene (MDPE) can be inadvertently added to the code 2 and 4 
recycling streams. DSC is a very effective method in separating the different types of Polyethylene.

011522_01
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FT-IR:

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 2959	 88

	 2	 2923	 84

	 3	 2857	 91

	 4	 1722	 75

	 5	 1580	 96

	 6	 1462	 90

	 7	 1426	 82

	 8	 1380	 91

	 9	 1255	 67

	PEAK NAME	 X (CM-1)	 Y (%T)

	 10	 1197	 89

	 11	 1123	 79

	 12	 1073	 78

	 13	 1040	 87

	 14	 1017	 88

	 15	 960	 78

	 16	 743	 83

	 17	 699	 77
Polyvinyl Chloride (PVC) Applications
• Pipes
• Cabling
• Construction Materials
• Medical Tubing and Bags

Pure PVC Analysis

A P P L I C A T I O N  B R I E F

Code 3a
Polyvinyl Chloride
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Pure PVC Analysis

DSC:

TGA:

011523_01
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Method:

TGA 4000/STA 6000 
Nitrogen purge 20 mL min-1

	 1.	Heat 30 to 900 ºC at 10 ºC min-1

		  a.	 Swap to air at 600 ºC at 30 mL min-1

	

Polyvinyl Chloride (PVC) Applications
• Pipes
• Cabling
• Construction Materials
• Medical Tubing and Bags

Detection of Additives 
in PVC by TGA

A P P L I C A T I O N  B R I E F

Code 3b
Polyvinyl Chloride (PVC)
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Detection of Additives in PVC by TGA

Discussion:

The functionality of materials can be greatly enhanced through additives and design. In some cases, such as Polyvinyl Chloride 
(PVC), utilizing the second derivative helps to identify subtle differences in formulation such as plasticizer content. This data analysis 
method assists in identifying shoulders that may otherwise be overlooked. 

011524_01



16

FT-IR:

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 2916	 33

	 2	 2848	 38

	 3	 1742	 97

	 4	 1641	 97

	 5	 1473	 73

	 6	 1463	 71

	 7	 1378	 96

	 8	 730	 74

	 9	 719	 64

Low Density Polyethylene (LDPE) Applications 
• Containers
• Food Packaging 
• Toys
• Cabling

Pure LDPE Analysis

A P P L I C A T I O N  B R I E F

Code 4a
Low Density Polyethylene
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Pure LDPE Analysis

DSC:

TGA:

011525_01
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FT-IR:

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 2950	 93

	 2	 2918	 90

	 3	 2839	 96

	 4	 1456	 95

	 5	 1376	 92

	 6	 1168	 98

Polypropylene (PP) Applications
• Containers
• Piping
• Fibers/Clothing
• Packaging

Pure PP Analysis

A P P L I C A T I O N  B R I E F

Code 5a
Polypropylene
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Pure PP Analysis

DSC:

TGA:
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Method:

DSC 4000 or 6000 
Nitrogen 20 mL min-1

	 1.	Heat from 25.00 ºC to 200.00 ºC at 10.00 ºC/min
	 2.	Hold for 2.0 min at 200.00 ºC
	 3.	Cool from 200.00 ºC to 25.00 ºC at 10.00 ºC/min
	 4.	Hold for 2.0 min at 25.00 ºC
	 5.	Heat from 25.00 ºC to 200.00 ºC at 10.00 ºC/min

Polypropylene (PP) Applications
• Containers
• Piping
• Fibers/Clothing
• Packaging

Analysis of the Effect of 
Filler on PP by DSC

A P P L I C A T I O N  B R I E F

Code 5b
Polypropylene
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Analysis of the Effect of Filler on PP by DSC

Discussion:

Fillers can have a significant impact on the crystallization of Polypropylene. The way a material crystallizes impacts its mechanical 
performance and clarity. DSC allows for the characterization of the crystallization properties of Polypropylene.

011527_01
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FT-IR:

Polystyrene (PS) Applications
• Food packaging
• Electronics housing 
• Insulation
• Disposable dining utensils

Pure PS Analysis

A P P L I C A T I O N  B R I E F

Code 6a
Polystyrene

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	  3026 	 94

	 2 	 2923 	 88

	 3 	 2853 	 94

	 4 	 1741	 97

	 5 	 1601 	 93

	 6 	 1493 	 85

	 7 	 1452 	 84

	PEAK NAME	 X (CM-1)	 Y (%T)

	 8 	 1155 	 94

	 9 	 1028	  89

	 10 	 906 	 94

	 11 	 754 	 79

	 12 	 695 	 50

	 13 	 538 	 78
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Pure PS Analysis

DSC:

TGA:
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Method:

Spectrum Two FT-IR
• 4000-450 cm-1 
• 4 cm-1 resolution
• 4 scans

Polystyrene (PS) Applications
• Food packaging
• Electronics housing 
• Insulation
• Disposable dining utensils

Comparing HIPS to  
PS by FT-IR

A P P L I C A T I O N  B R I E F

Code 6b
Polystyrene
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Comparing HIPS to PS by FT-IR

Discussion:

High Impact Polystyrene is fairly difficult to separate from Polystyrene. One has to focus on the finger print region shown above. 
One of the best ways to separate the two is through PerkinElmer’s proprietary Compare algorithm.	

011529_01
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FT-IR:

Acrylonitrile Butadiene Styrene (ABS) Applications
• Automotive
• Protective Equipment
• Toys
• Electronics Housing

Pure ABS Analysis

A P P L I C A T I O N  B R I E F

Code 7a i
ABS

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1 	 3028 	 93

	 2 	 2925 	 89

	 3 	 2237 9	 3

	 4 	 1602 	 92

	 5 	 1494 	 82

	 6 	 1453 	 77

	 7 	 1363 	 93

	PEAK NAME	 X (CM-1)	 Y (%T)

	 8 	 1071 	 91

	 9 	 1029 	 88

	 10 	 966 	 86

	 11	 911 	 90

	 12 	 759 	 66

	 13 	 698 	 31
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Pure ABS Analysis

DSC:

TGA:

011530_01
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Method:

DSC 4000 or 6000 
Nitrogen 20 mL min-1

	 1.	Heat from -50.00 ºC to 200.00 ºC at 10.00 ºC min-1

	 2.	Hold for 2.0 min at 200.00 ºC
	 3.	Cool from 200.00 ºC to -50.00 ºC at 10.00 ºC min-1

	 4.	Hold for 2.0 min at -50.00 ºC
	 5.	Heat from -50.00 ºC to 200.00 ºC at 10.00 ºC min-1

Acrylonitrile Butadiene Styrene (ABS) Applications
• Automotive
• Protective Equipment
• Toys
• Electronics Housing

Detecting ABS Nylon  
Formulations by DSC

A P P L I C A T I O N  B R I E F

Code 7a ii
ABS
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Detecting ABS Nylon Formulations by DSC

Discussion:

There are many different Acrylonitrile Butadiene Styrene (ABS) formulations. Typically, they are characterized by their upper glass 
transition. In this particular case, a blend of nylon and ABS is detected. 

011531_01
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FT-IR:

Nylon Applications
• Fibers/Clothing
• Automotive
• Pipes/Tubing
• Machine Parts

Pure Nylon Analysis

A P P L I C A T I O N  B R I E F

Code 7b i
Nylon

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1 	 3297 	 83

	 2 	 2932 	 85

	 3 	 2859 	 90

	 4 	 1633 	 67

	 5 	 1537 	 69

	 6 	 1464 	 83

	 7 	 1417 	 85

	PEAK NAME	 X (CM-1)	 Y (%T)

	 8 	 1371 	 87

	 9 	 1274 	 83

	 10 	 1199	  86

	 11 	 1141 	 93

	 12 	 936 	 93

	 13 	 686 	 81

	 14 	 580 	 81
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Pure Nylon Analysis

DSC:

TGA:

011532_01
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Method:

DSC 4000 or 6000 
Nitrogen 20 mL min-1

	 1.	Heat from 25.00 ºC to 290.00 ºC at 10.00 ºC min-1 
	 2.	Hold for 2.0 min at 290.00 ºC
	 3.	Cool from 290.00 ºC to 25.00 ºC at 10.00 ºC min-1 
	 4.	Hold for 2.0 min at 25.00 ºC
	 5.	Heat from 25.00 ºC to 290.00 ºC at 10.00 ºC min-1 

Nylon Applications
• Fibers/Clothing
• Automotive
• Pipes/Tubing
• Machine Parts

Filled Nylon Comparison  
by DSC

A P P L I C A T I O N  B R I E F

Code 7b ii
Nylon
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Filled Nylon Comparison by DSC

Discussion:

By using DSC, one can approximate the polymer content by using a known standard to ratio against or by generating a 
concentration versus enthalpy calibration curve.
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Method:

Spectrum Two FT-IR
• 4000-450 cm-1 
• 4 cm-1 resolution
• 4 scans

Nylon Applications
• Fibers/Clothing
• Automotive
• Pipes/Tubing
• Machine Parts

Filled Nylon Comparison  
by FT-IR

A P P L I C A T I O N  B R I E F

Code 7b iii
Nylon
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Filled Nylon Comparison by FT-IR

Discussion:

The addition of inorganic fillers to thermoplastics is common. This is either to reduce cost, improve stability, or to enhance 
mechanical properties. In this particular case, nylon has a glass filler to enhance its strength. There is one peak associated with the 
glass filling, around 1019 cm-1. Using PerkinElmer’s Spectral Subtraction algorithms, it’s possible to identify and isolate additive 
packages (see insert).
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Method:

TGA 4000/STA 6000 
Nitrogen purge 20 mL min-1

	 1.	Heat 30 to 900 ºC at 10 ºC min-1

		  a.	 Swap to air at 600 ºC at 30 mL min-1

Nylon Applications
• Fibers/Clothing
• Automotive
• Pipes/Tubing
• Machine Parts

Filled Nylon Comparison  
by TGA

A P P L I C A T I O N  B R I E F

Code 7b iv
Nylon
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Filled Nylon Comparison by TGA

Discussion:

One of the most effective ways to quantify fillers is through the TGA. In this example, pure nylon is over laid with a filled nylon 
sample. Since pure nylon has 0% ash, all of the ash can be accounted for in the unknown as glass filler. The identity of the filler 
can be determined through the use of FT-IR or ICP-OES on the ash.
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FT-IR:

Polycarbonate Applications
• Safety Materials
• Food and Beverage Containers
• Artificial Glass
• Electronic Housing

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 2968	 84

	 2	 1769	 33

	 3	 1602	 91

	 4	 1504	 44

	 5	 1465	 85

	 6	 1410	 84

	 7	 1387	 88

	 8	 1365	 84

	 9	 1291	 82

	 10	 1219	 15

	 11	 1187	 6

	PEAK NAME	 X (CM-1)	 Y (%T)

	 12	 1159	 5

	 13	 1102	 52

	 14	 1080	 32

	 15	 1014	 21

	 16	 919	 83

	 17	 887	 64

	 18	 829	 39

	 19	 815	 47

	 20	 767	 56

	 21	 731	 73

	 22	 703	 67

Pure PC Analysis

A P P L I C A T I O N  B R I E F

Code 7c i
Polycarbonate
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Pure PC Analysis

DSC:

TGA:
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Method:

Spectrum Two FT-IR
• 4000-450 cm-1 
• 4 cm-1 resolution
• 4 scans

Polycarbonate Applications
• Safety Materials
• Food and Beverage Containers
• Artificial Glass
• Electronic Housing

Comparing PC to PS  
by FT-IR

A P P L I C A T I O N  B R I E F

Code 7c ii
Polycarbonate
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Comparing PC to PS by FT-IR

Discussion:

Polycarbonate (PC) and Polystyrene (PS) are often confused with each other when in rubbish or waste. FT-IR can easily identify the 
two. The primary bands of interest are the carbonyl at approximately 1700 cm-1. By checking for this band, one can quickly 
differentiate Polycarbonate from other high clarity thermoplastics.	
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FT-IR:

Poly(Methyl Methacrylate) (PMMA) Applications
• Artificial Glass
• Electronics
• Automotive
• Construction

	PEAK NAME	 X (CM-1)	 Y (%T)

	 1	 2993	 90

	 2	 2951	 84

	 3	 2850	 95

	 4	 1723	 27

	 5	 1435	 69

	 6	 1386	 83

	 7	 1270	 70

	 8	 1239	 60

	 9	 1189	 51

	PEAK NAME	 X (CM-1)	 Y (%T)

	 10	 1143	 27

	 11	 987	 71

	 12	 965	 75

	 13	 841	 79

	 14	 826	 88

	 15	 810	 89

	 16	 751	 73

Pure PMMA Analysis

A P P L I C A T I O N  B R I E F

Code 7d i
Poly(Methyl Methacrylate)
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Pure PMMA Analysis

DSC:

TGA:

011538_01



44

Method:

Spectrum Two FT-IR
• 4000-450 cm-1 
• 4 cm-1 resolution
• 4 scans

Poly(Methyl Methacrylate) (PMMA) Applications
• Artificial Glass
• Electronics
• Automotive
• Construction

Comparing PMMA  
to MPMMA by FT-IR

A P P L I C A T I O N  B R I E F

Code 7d ii
Poly(Methyl Methacrylate)
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Comparing PMMA to MPMMA by FT-IR

Discussion:

FT-IR can be used to look for differences between Polymethyl Methacrylate (PMMA) samples. In this example, impact-resistant 
PMMA is compared to standard PMMA.
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Method:

TGA 4000/STA 6000 
Nitrogen purge 20 mL min-1

	 1.	Heat 30 to 900 ºC at 10 ºC min-1

		  a.	 Swap to air at 600 ºC at 30 mL min-1

Poly(Methyl Methacrylate) (PMMA) Applications
• Artificial Glass
• Electronics
• Automotive
• Construction

Comparing PMMA  
to MPMMA by TGA

A P P L I C A T I O N  B R I E F

Code 7d iii
Poly(Methyl Methacrylate)
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Comparing PMMA to MPMMA by TGA

Discussion:

When a polymer system is modified, a certain amount of thermal stability can be added. Utilizing TGA, one can determine the 
change in thermal stability based on the formulation. The first and second derivatives are helpful in this measurement.
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Recycled Polymer Compendium – User Guide
The information in this document is put forth as a tool to guide 
users in the analysis of polymer materials. All of the data 
presented was collected with PerkinElmer instruments on new/
clean resins. Remember that actual formulations encountered in 
the marketplace have been optimized to enhance the properties 
of the polymer. Some enhancements could be color, structural, 
cost, UV-protection etc. This guide does not attempt to address 
all additives and enhancements utilized in the seven codes of 
polymers. It does, however, provide methods and techniques  
to guide users through the detection and possible identification 
of unknown enhancements. Below, the user will find a brief 
overview of the steps required to reproduce the data within the 
compendium as well as precautionary information pertaining to 
the three instrument classes employed in this study.

Instrument and Sample Guidelines

1.	� Fourier Transform Infrared Spectroscopy  
(FT-IR – Spectrum Two)

Preparing the Instrument
To begin the analysis by FT-IR, several items need to be prepared:

•	� Verify that the instrument has successfully passed its “Ready 
Checks,” specifically the contamination check.

•	� If the contamination check fails, clean the diamond ATR 
crystal using an appropriate solvent and delicate wipe. This 
author is a proponent of 91% isopapanol and disposable 
laboratory wipes.

•	� Allow enough time for the solvent to evaporate then re-run 
the contamination check.

After the instrument is verified as being ready to operate, no 
more ready checks are required that day, unless the user’s SOP 
specifies otherwise. 

Preparing for Analysis
Included in the compendium media device is an FT-IR library file.  
This library should be added to the list of searchable items. A 
detailed description of how to set up library files can be obtained 
within the “Spectrum 10 Tutorials” found in the “Help” Menu.

Within the same folder as the library file, resides a “.SET” file. This 
file should be imported into the instrument configuration page. 
See Figures 1 and 2 for import and activation tips.

Now that the instrument is configured, a “background scan” is 
required. Verify that the pressure arm tip is not near the 
diamond face before pressing the scan “Background” button 
(Figure 3).

Preparing the Sample 
Using a clean sharp knife (razor blade or hobby knife), cut the 
sample such that it has at least one flat side, but two are 
preferred so the faces are parallel to each other (Figure 4). Avoid 
grinding or “dry” sanding the sample as the friction/heat can alter 
the material’s behavior.

Place the newly cut flat face on the diamond and lower the 
pressure arm down until contact is achieved, but do not tighten 
past contact.

Figure 1. “Setup Instrument Basic” tab. This is the area where the methods  
are configured.

Figure 2. Instrument Toolbar. Highlighted is the button which allows for the 
rapid configuration of the instrument.

Figure 3. Identifying the “Scan,” “Background” and “Scanalyze” buttons on the 
instrument control panel.

Figure 4. Example of a polymer sample cut to have a flat top and bottom, for 
measurement by both DSC and FT-IR. This sample began as a “chip” 
(depending on the resin used, the common name used for unprocessed 
polymer may vary between “flake, chip, pellet, etc.)
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Measurement
Press the “ScanAlyze” button then highlight “Scan and Search” 
(Figure 3). This action will put the instrument into what is called 
“Preview Mode”. Once the real-time display becomes active, 
begin applying pressure to the sample. Watching the force meter, 
continue turning the dial until 90-100 counts is displayed. If peaks 
are clearly observed, and the largest one is greater than 90%T, 
then press the “Scan” button (Figure 3) to begin data acquisition 
and the search. If the sample does not exceed 90%, then remove 
the force from the sample and reposition, recut, etc., until the 
sample does meet this requirement. Under no circumstance 
should additional force be applied beyond 100 counts as this 
could alter the sample crystal structure.

Data Analysis
As the data is collected, the search process is already underway. 
By the time the experiment is complete, the best match will be 
displayed. In an ideal situation, the best hit will have a score of 
“1.0”, however, this will never occur. Typically, a score greater 
than 0.90 is considered a reasonable hit (Figure 5). The closer the 
hit index is to 1, the more confident the analyst can be in the 
result. If the best hit is less than 0.9, it becomes time to analyze 
the sample in a more analytical fashion. Within each of the 7 code 
folders, a data file is provided of the pure polymers. Open the 
suspected data file and overlay it with the unknown sample and 
look for differences (Section 7,d, ii in the compendium).

The more common inorganic additives always appear in the same 
general regions. Over time, the user will be able to spot them 
rapidly. If the spectra are wildly different, then it may be possible 
that a polymer blend is present. If a polymer blend or filled material 
is suspected, then the laboratory should have a set protocol in 
place for the accepting or rejecting of such polymer lots. 

Cautionary Information
•	� All data collected in this compendium was obtained utilizing a 

specific set of instrument parameters. Included in the shipping 
materials is a Setup file. The extension of this file is “.SET” this 
includes all of the conditions for the execution of the 
experiments used in the provided library. 

•	� The measurements were all obtained using a Diamond-
attenuated total reflectance accessory (UATR), KBr sample 
compartment windows and a DTGS detector. Any deviation 
from this configuration could result in a deviation from the 
presented data.

•	� Peak labels are provided for reference only. Peaks can shift due 
to the pressure applied using the force arm, percent crystallinity, 
and additives in the polymer. Do not expect your peaks to be in 
the exact same position as those listed in the compendium.

2. Differential Scanning Calorimetry (DSC 4000/DSC 6000)

Preparing the Instrument
To begin the analysis of polymers by DSC, the instrument must be 
properly configured and equilibration reached. Activate an inert 
purge gas such as nitrogen (N2) (Figure 6) with a delivery pressure 
between 25-30 psi. Proper gas pressures are typically set by a 
PerkinElmer-authorized service representative at the point of 
installation. Activate Pyris™ software and verify that the 
instrument/software connection is achieved. Set the instrument 
temperature to 50 °C using the “GoTo” temperature button 
(Figure 6). Activate the cooling device attached to the instrument. 

Figure 5. Example output from the “ScanAlyze” analysis.

Figure 6. Instrument control bar in Pyris software. Highlighted is the  
“GoTo” temperature and “Apply” purge gas sections.
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Notes for Cooling Devices
If water-cooling is utilized, verify the coolant is at the proper  
level and no contamination is visible by inspecting the tank.  
If an intracooler is being used, make sure that the transfer  
line is not kinked or pinched. Note that once you activate the 
intracooler, the transfer line cannot be moved. In both cases,  
the cooling device needs to be powered on for a minimum of  
1.0 hour prior to making any measurements. It is not uncommon 
for some test laboratories to wait for 1.5 hours prior to starting 
any measurement. 

Notes on Calibration
It is good practice to “check” the instrument calibration on a 
regular basis and recalibrate as needed. Typically, DSCs are 
checked and calibrated with the following reference materials: 
indium (In), zinc (Zn), tin (Sn), and/or gallium (Ga). This policy 
should be outlined in the laboratory SOP (standard operating 
procedure).

Method Editor Configuration
Each of the polymers covered in this compendium have a specific 
DSC method associated with them. Some of the methods require 
an intracooler to achieve the best results. Pick the method which 
best suits the suspected material in its respective folder on the 
compendium media device. Feel free to alter the temperature 
ranges so long as the maximum temperature stays below the 
degradation temperature of the sample. Do not alter the number 
of steps or the heating rates of the steps between samples, as 
otherwise, the user will not be able to compare the data 
generated. If the maximum safe temperature is unknown, then  
a TGA should be implemented.

With the method editor as the active window (Figure 7) go  
to File → Open and navigate to the media device to locate  
the method.

Sample Preparation
Depending on the instrument configuration, either standard 
aluminum pans or autosampler aluminum pans should be utilized. 
The sample should be prepared in accordance with the  
following guidelines:

•	� Cut the sample such that it will neatly fit inside of the sample 
pan. The sample should have one flat side that touches the 
bottom of the pan (Figure 4).

•	� The sample mass should be between 5-10 mg, and reported to 
the second decimal place, such as “5.51 mg.” The laboratory 
SOP should identify the exact target sample mass and the 
desired precision. Once the mass has been properly 
determined, the sample should be encapsulated with the 
correct cover and crimping device. 

•	� Using a delicate laboratory wipe, clean any fingerprints or 
sample which may have accumulated on the sample pan.

Preparing for the Measurement
Using the “GoTo” temperature button, lower the instrument 
temperature to a safe level, (less than 30 °C) (Figure 6). Load the 
sample into the instrument. If an autosampler is equipped, then let 
the instrument place the sample, otherwise use forceps. Verify that 
the furnace covers have been returned to their correct locations.

Executing the Measurement
On the “Sample Information” tab of the Method Editor (Figure 7), 
enter the mass of the sample to be analyzed. In “Save Location”, 
type in a name which best describes the sample. In the Notes 
sections, enter in any pertinent information, which will assist 
future analysts in determining the goal of this project. Figure 7 
provides a nice example of how the fields in the “Sample 
Information” tab should be filled in. The population of these text 
fields should be outlined in the lab SOP. With a single mouse click, 
press the “Start” button (Figure 8). Typically, the measurement 
will take greater than 30 minutes — allow enough time for the 
experiment to complete. If the measurement is stopped 
prematurely, the progress to that point will be saved.

Figure 7. Example of fully-populated DSC Method Editor.

Figure 8. DSC “Start/Stop” button.
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Analyzing the Data
Each of the seven codes has data files associated with them  
in their respective folders. The goal of the analysis will be to 
answer three idealized questions:

1)	 Is this the correct polymer?

2)	 Is it a mixture of polymers?

3)	 How much of the polymer is present?

These questions can be answered quickly and easily using  
the following methodology. 

To begin, the data files for the unknown sample and a pure 
material must be prepared for analysis. This process is called 
“separating the curves.” Using the “Curves” menu, select the 
experiment intervals that will be analyzed. Some DSC files are 
provided to assist in this analysis. Look to the media device to  
load these samples.

Typically, the second heating is the curve of interest. Using the 
“Shift Curve” button found on the toolbar, adjust the segments 
so that the second heat curves for the unknown material and  
for the reference polymer overlap each other. This may also 
require use of the Slope button to align them as closely as 
possible. Now compare the peaks and glass transitions in these 
two curves and ask, “Are they close to each other?” If the answer 
to that question is “no,” then look for another polymer and 
repeat the process. 

If the identity can’t be confirmed, it is now time to answer the 
question “could this be a mixture of polymers?” Overlay the 
polymers which may constitute the observed mixture. An  
example of this process can be found in section 7, a, ii of  
this compendium. 

“What percent of the unknown can be attributed to the 
polymer?” This is an estimation to make after determining the 
identity/ies of the unknown sample. This can be achieved by two 
methods, the melting enthalpy and/or the delta Cp. The enthalpy 
of melting the unknown should be less than or equal to that of 
the pure polymer. Simply divide the enthalpy of the unknown by 
that of the standard, and multiply by 100 to get the approximate 
polymer percent in the unknown. An example for this can be 
found in section 7, b, ii of this compendium. 

In the example mentioned above, the suspected glass filler was 
33%, however, TGA analysis revealed the % glass to be 29% 
with about 2.5% moisture (7, b, iv). It is not uncommon for errors 
in formulation to occur. As can be seen here, the utilization of 
DSC and TGA has proven that the sample is significantly less filled 
than what was implied.

If no melting peak is observed for the polymer, the glass transition 
(Tg) is to be utilized in this measurement. Typically, this number 
will be less than 1.0 and displayed to the 3rd decimal place. If this 
is the only means of estimating the percent of polymer present, 
then great care must be taken to get the sample mass as accurate 
as possible. The calculation is identical to that of the melting.

Notes on Quantitation
A great deal of caution should be expressed at this point as this 
will not be an exact value, only a reasonable approximation. The 
addition of fillers, additives, and polymer blends can greatly 
influence this measurement. If exact values are required, then 
modified DSC, TGA, and/or FT-IR methods are available but are 
not covered within the guide.

Cautionary Information
•	� All data collected in this compendium was obtained utilizing a 

specific set of instrument parameters. Included in the shipping 
materials are “method” files — the file extension is “.D6m”. 
Each of the seven codes has its own unique method file.

•	� The samples were encapsulated in standard aluminum  
DSC pans.

•	 Sample masses were between 8.5-10.5 mg.

•	� All peaks displayed in this compendium are for reference 
purposes only. Note that peaks can shift not only in 
temperature but also intensity due to the addition of  
additives or the blending of polymers. Use the peak  
positions and areas as a guide to identify the polymer  
and its approximate concentration.

3. Thermogravimetric Analysis (TGA 4000/STA 6000)

Preparing the Instrument
To begin the analysis of polymers by TGA, the instrument must be 
properly configured and equilibration reached. Activate the inert 
purge gas, nitrogen (Figure 9). The delivery pressure for all 
incoming gases should be between 25-30 psi (this is normally 
configured by your PerkinElmer-authorized service representative 
at the point of installation.) Verify that the instrument is powered 
on. Activate Pyris software and verify that the instrument/software 
connection is achieved. Set the instrument temperature to 30 °C 
using the “GoTo” temperature button (Figure 9). Activate the 
cooling device attached to the instrument.	
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Notes for Cooling Devices
Water-cooling is utilized for both the STA 6000 and TGA 4000. 
Make sure that the coolant level is correct and no contamination 
is visible by inspecting the tank. The cooling device needs to be 
powered on for a minimum of 1.0 hour prior to making any 
measurements. It’s not uncommon for laboratories to wait for 1.5 
hours prior to starting any measurement.

Notes on Calibration
It is good practice to “check” the instrument calibration on a 
regular basis and recalibrate as needed. This policy should be 
outlined in the laboratory SOP (standard operating procedure).

Method Editor Configuration
Within the compendium media device, two TGA methods are 
provided. One method is generic and the other is optimized for 
carbon black containing polymers. Choose the one that best 
meets the requirements of the sample. Make the Method Editor 
the active window, then go to File → Open and navigate to the 
media device to locate the method (Figure 10).

Sample Preparation
Preparing samples for a TGA is typically and easy endeavor, 
however, care must be taken to do so in a repeatable manner. 
The laboratory should establish a set of protocols for the 
preparation of samples. The SOP should address the following:

•	� Is the sample presented as a single piece, chopped, or ground 
up? Care should be taken when cutting, chopping, or grinding 
to not introduce foreign material. 

•	� Is the sample placed in a platinum or alumina sample crucible? 
Platinum is typically the preferred option, but cost tends to 
push laboratories to alumina. Alumina sample pans will work 
fine for most polymers, but they do have a limited lifetime.

•	� Does the sample contain carbon black? If the sample has  
this additive, then more time may be required to complete  
the burn off, or oxygen as a purge gas may be required. Feel 
free to increase the hold times and gas flow rates in the 
provided methods.

•	� Does the sample contain inorganic fillers? If the sample 
contains such additives, then a considerable amount of ash  
will remain in the TGA pan – make sure to clean the residue 
out properly.

Setting Up the Instrument
Make the Method Editor the active window (Figure 10). In  
“Save Location”, enter a name that best suits the unknown 
sample and populate the remaining fields in accordance with  
the laboratory SOP. 

Using the “GoTo” temperature button (Figure 9), set the 
instrument temperature to 30 °C. Verify the instrument is stable 
before tarring or weighing any pans/samples. Place an empty 
sample crucible on the sensor. If the instrument has an 
autosampler, allow it to insert and remove the crucible. Tare the 
sensor, then remove the crucible. Never attempt to put a sample 
into a pan that is still in the instrument. Place the sample into the 
holder then return it to the sensor. Allow the instrument to 
stabilize then record the mass of the sample into the method 
editor (Figures 9 and 10). 

Executing the Measurement
Verify that all of the appropriate fields have been populated as 
outlined in the lab SOP (Figure 10). With a single mouse click, 
press the “Start” button (Figure 9). Typically, the measurement 
will take greater than 45 minutes – allow enough time for the 
experiment to complete. If the measurement is stopped 
prematurely, the progress to that point will be saved.

Figure 9. TGA/STA control panel. 

Figure 10. Example of fully-populated TGA Method Editor.



53

User Guide User Guide

Analyzing the Data
It is this author’s preference to view TGA data such that the “X” 
axis is in Time rather than Temperature when calculating percent 
weight loss, however, when comparing samples, it’s good to 
overlay them with the “X” axis in temperature. This swap in axis is 
easily achieved using the “T/t” button on the tool bar. In the spirit 
of simplicity, all TGA data provided in this compendium is 
presented with temperature scaling.

In each of the seven code folders, example TGA data files are 
provided for practice. Many types of each polymer exist. One 
example would be nylon, which has many forms such as 6, 6/6, 
6/12 etc. Should the user require a more robust means of 
identifying the material, FT-IR or DSC are better choices as additive 
packages can greatly influence degradation. If the laboratory has a 
reference material for comparison, add the polymers using the 
“Add” function in the “File” menu. Utilizing both the Weight % 
and 1st derivative of the Weight %, verify the identity of the 
polymer (Figure 11).

Convert the Weight % curves from temperature to time. Remove 
the 1st derivative curves using the “Remove” button. Note the 
similarities and differences between pure polymer and the 
unknown material. Specific attention should be placed on the 
region after 600 °C as this is the area where carbon black and 
inorganic fillers are often determined. Using the “Event Mark” 
and “Step” calculations found in the “Calc” menu, determine 
moisture, carbon, ash etc. Section 7, b, iv in this compendium 
shows an excellent example for these calculations.

If an FT-IR is available, it is possible to identify some inorganic 
fillers such as glass, talc, calcium carbonate, etc. After the TGA 
has cooled back to a safe temperature, remove the sample 
crucible and empty the contents on the diamond ATR to collect 
the spectra (Figure 12). If the identity of the filler is already known, 
save the FT-IR file so that it can be used for future library searches. 

Cautionary Information
•	� All data collected in this compendium was obtained utilizing a 

specific set of instrument parameters. Included in the shipping 
materials are two “method” files. The extension of the files is 
either “.t6m” or “.stam”. Depending on the polymer system, 
one method may be more favorable than the other.

•	� Be consistent in the sample preparation, including particle size, 
and weights – typically 5-10 mgs of sample is recommended.

•	� All peaks and steps displayed in this compendium are for 
reference purposes only. Note that peaks and steps can shift 
not only in temperature but also intensity due to the addition 
of additives or the blending of polymers. Use the peak 
positions of first derivatives and step height as a guide to 
identify the polymer and its approximate concentrations.

Instrument and Software Training
For a more complete set of instructions on the proper operation 
of the instruments, contact PerkinElmer for instrument and 
software training classes which are regularly scheduled 
throughout the year. Please visit www.perkinelmer.com/training  
or contact your account manager to learn more about instrument 
training opportunities.

Figure 11. Example usage of the 1st derivative plots to determine identity of a 
polymer. In this case, there is a clear difference between the two forms of nylon.

Figure 12. FT-IR analysis of the ash remaining in a TGA pan.
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